Unit 11. Introduction to Form and Report

Introduction:
Databases are made to be used. Access provides an easy way to enter data into Access database tables with forms. Forms can also use to edit, update or display data. Forms offer more user-friendly interface by adding labels for each field and other helpful information.

Switchboards: You can create form that appears as a switchboard. The switchboard provides a friendly and controlled way to open forms, reports, and other objects. It guides users to the actions that you want them to perform, and screens parts of your database.

Lesson 11.1: Form
Learning Objectives

On completion of this lesson you will be able to learn:
- about form.
- creating form.
- about form toolbox.

11.1.1 Form
A form is a graphical representation of a table. Generally a form is created to enter data efficiently and accurately in a table. It is like a window into a table, designed to display the data. Forms can be designed to show all or some of the fields in a table or to combine the fields from two or more tables.

All sorts of people need to add and review data quickly and effectively. Entering data in a form is more efficient than entering it in a table. A visually attractive form makes working with the database more pleasant and more efficiently.

11.1.2 Creating Form
Access offers two main methods of creating a new form.
1. Design view.
2. Form Wizard

Creating Form in Design View
Design view is the best way to create a form when you want full control and complete freedom. In Design view, everything is up to you.

To start working in Design view:
1. In the database window click Forms under Objects.
2. Click the New button on the Database window toolbar.
3. In the New Form dialog box click Design View to select this method.
4. Click the name of the table or other record source that includes the data you want to base your form on.

5. Click OK.

After Design
To see the form as it will appear you can open it in Form view and keep switching between Form and Design views until the form suits you completely.

Navigation Button
Access automatically adds navigation button to every new form because they are so convenient. The navigation button isn't visible in Design view, but it appears whenever you switch to Form view. Using navigation button users move quickly and easily back and forth among the records or to the end of the existing records to create a new record.

**Creating Form by using Wizard**

The Form Wizard is best when you want to be guided step by step through the process of creating a form. The Form Wizard asks you questions and creates a form based on your answers.

You will need to tell the wizard:

- Which table or query the form data comes from?
- Which fields to use on the form?
- Which form layout to apply?
- Which visual style to apply?

To create form using wizard:

1. In the database window click Forms under Objects.
2. Click the New button on the Database window toolbar.
3. In the New Form dialog box click one of the following wizards:

   - AutoForm: Columnar each field appears on a separate line with a label to its left.
   - AutoForm: Tabular the fields in each record appear on one line, with the labels displayed once at the top of the form.
   - AutoForm: Datasheet the fields in each record appear in row-and-column format, with one record in each row and one field in each column. The field names appear at the top of each column.
   - AutoForm: PivotTable the form opens in PivotTable view. You can add fields by dragging them from the field list to the different areas in the view.
• AutoForm: PivotChart: the form opens in PivotChart view. You can add fields by dragging them from the field list to the different areas in the view.

4. Click the table or query that includes the data you want to base your form on.
5. Click OK.

![New Form dialog box](image1)

Choose the table or query where the object's data comes from:

- **student**

![Columnar AutoForm](image2)

**Fig. A columnar AutoForm**

![Tabular AutoForm](image3)

**Fig. A tabular AutoForm**
11.1.3 Toolbox
The Toolbox contains a set of controls that are used to receive user input and display output on a form at design time. Controls have their own set of properties, methods, and events. Properties define aspects of their appearance such as size, color, etc., and aspects of their behavior such as their response to user input. A method is an action that can be performed on objects.

Label - A Label control is a graphical control which is used to display text that the user cannot modify directly.

On a Form
1. Open a form in design view
2. Click the Label tool in the toolbox.
3. Click the section on the form where you want to place the label.
4. Set other properties to customize the visual appearance of the label and its contents.

* To set properties for control click the control and then click Properties on the toolbar.

Textbox - Textbox control sometimes called an edit field or edit control is used to display information at design time or assigned to the control in code at run time.

On a Form
1. Open a form in design view
2. Click the Text box in the Toolbox.
3. Click in detail section where you want to place the textbox.
4. Set other properties to customize the visual appearance.

* To set properties for control click the control and then click Properties on the toolbar.
Office Automation and MS Office

The Textbox control has associated methods such as refresh, Setfocus, etc. The Setfocus method moves the focus the control. The Textbox control supports various events such as change, click, and many more that will be listed in the properties drop-down list in the code window for the textbox control. As for example-The code entered in change event executes when there is a change in the contents of the textbox. The Click event fires when the Textbox control is clicked.

Command button- The Command button carries out the specified action as desired of user. In other words a command button control is used to begin, interrupt, or end a process. To display text on a command button control, set its Caption property. An event can be activated by clicking a command button.

Check box - Check box displays a True/False or Yes/No option.

List Box - List Box display a list of items from which you can select one.

Image - Image control is used to display icons, bitmaps etc.

Picture Box - Picture Box displays icons/bitmaps files. It also displays text or acts as a visual container for other controls.

Frame control- Frame control serves as a visual and functional container for controls.

Shape control- Shape control adds a shape (rectangle, square or circle) to a form.

Line control- Line control draws a straight line to a form.

Pointer- pointer provides a way to move and resize the controls and forms.
Introduction to Form

Exercise

1.  **Multiple choice questions**

   a.  Navigation button is visible

      i)  design time
      ii) form view
      iii) both i and ii
      iv) none of the above.

   b.  Which control display a list of items from which you can select one?

      i)  list Box
      ii) check box
      iii) picture bix
      iv) shape control.

   c.  Field in each record appear in row and column format with one record in each row and one field in each column

      i)  autoform columnar
      ii) autoform tabular
      iii) autoform datasheet
      iv) autoform PivotTable

2.  **Analytical questions**

   1.  What is Form? Write the benefits of form.
   2.  Write the steps required to create a form in design time.
   3.  Write the steps required to create a form using wizard with examples?
   4.  Discuss about the controls of Form toolbox.
Lesson 11.2: Designing Report

Reports are the end product of database and report is an effective way to present data in a printed format. You can group your assets by supplier and calculate a subtotal for each group, as well as a grand total for all groups. In this lesson we will discuss about creating, modifying, and sections reports.

Learning Objectives
On completion of this lesson you will be able to learn:
- about report.
- about sections of report.
- creating report.

11.2.1 Report
One database may have many reports. Some will be based on one table data others may be based on specific queries. As the data changes (added or deleted) or the query changes the report is change automatically.

11.2.2 About Sections of a Report
The information in a report can be divided into sections. Each section has a specific purpose and prints in a predictable order in the report. Access report layout consists of five major sections. Within these sections you can place fields, text, and graphics.

Five major sections are as follows:
1. Report header
2. Page header
3. Detail (data from tables)
4. Page footer
5. Report footer

The report header appears once at the beginning (First page) of report. As for example such as company logo, introductory information, or
report title. The report header is printed before the page header on the first page of the report.
The page header appears at the top of each page in the report often used to display information such as report titles.
The detail section is the main body of report’s data. All reports must have a detail section.
The page footer appears at the bottom of every page in the report. Page footer is similar to page header except that it appears at the bottom of each page. It is used to display items such as page numbers, printing date. You can also create group footers that display sums, counts, or averages for a group of data.

The report footer appears once at the end of the report. It is used to display items such as report totals. The report footer is the last section in the report design but appears before the page footer on the last page of the printed report.

11.2.3 Creating Report
There are three ways to create a report.
• Creating report in Design view.
• Creating report using Wizard.
• Creating report using Autoreport.

Creating Report in Design View
You can create and customize report in Design view

1. In the database window click Reports under Objects
2. Click the New button on the Database window toolbar.
4. Click the table or query that contains the data you want to base your report on.
5. Click OK.
Office Automation and MS Office

You can use Toolbox to enhance Visual appearance of your report. Click the label tool from toolbox, place it in the report header section and type Bangladesh Open University. Set other properties to customize the visual appearance of the label and others tool and its contents.

Creating Report using Wizard
The wizard asks you detailed questions about the record sources, fields, layout, and format you want and creates a report based on your answers.
1. In the database window click Reports under Objects.

2. Click the New button on the Database window toolbar.

3. In the New Report dialog box click the wizard that you want to use. In the left side of the dialog box description of the wizard appears.

4. Click the table or query that contains the data you want to base your report on.

5. Click OK.

6. Follow the instructions in the wizard.

If the resulting report doesn't look as you desire you can change it in Design view.
Office Automation and MS Office

Fig. A columnar layout.

Fig. A tabular layout.
Introduction to Form

Fig. A columnar layout

![Columnar layout example](image1.png)

Bangladesh Open University

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>gp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>kohab</td>
<td>4.5</td>
</tr>
<tr>
<td>2</td>
<td>manan</td>
<td>4</td>
</tr>
<tr>
<td>3</td>
<td>kabir</td>
<td>4.5</td>
</tr>
<tr>
<td>4</td>
<td>rafia</td>
<td>4.5</td>
</tr>
</tbody>
</table>

Fig. A tabular layout

**Creating Report using AutoReport**

AutoReport creates a report that displays all fields and records in the underlying table or query.

1. In the database window click Reports under Objects.
2. Click the New button on the Database window toolbar.

3. In the New Report dialog box click one of the following wizards:
   AutoReport: Columnar each field appears on a separate line with a label to its left.
   AutoReport: Tabular the fields in each record appear on one line and the labels print once at the top of each page.

4. Click the table or query that contains the data you want to base your report on.

5. Click OK.

11.2.4 Saving a Report
You can either click-on File (in the Menu Bar) and then Save, or Save As, or click-on the small diskette button in the button bar. A menu window will open which asks Save As. In the area under Report Name type the name of the report and click-on OK. Click-on the File in the Menu Bar and then click-on Close.

Now when you return to the Database Window, you will see your report is in the list.

To save a report in Access 2000, follow these steps:
1. Click on the File menu in the Access window.
2. Choose Save As.
3. Enter a name for your report in the Save As dialog box.
4. Click OK to save the report.

Now when you return to the Database Window, you will see your report is in the list.
11.2.5 Open a Report
1. In the database window click Reports under Objects.
2. Click the report which you want to open.
3. Do one of the following:
   - Click Design on the Database window toolbar to open the report in Design view.
   - Click Preview on the Database window toolbar to open the report in print preview.

11.2.6 Modifying a Report
1. To modify a report open the report and go to Design view
2. Edit the field designs by dragging, stretching or deleting.
3. Switch to the report view to see how it looks.
4. Repeat the procedure until the reports look good.
Exercise

1. **Multiple choice questions**

   a. Each field appears on a separate line with a label to its left
      
      i) autoReport: Columnar
      ii) autoReport: Tabular
      iii) autoReport: Datasheet
      iv) none of the above.

   b. Report must have a
      
      i) detail section
      ii) page header section
      iii) page footer section
      iv) report header.

2. **Analytical questions**

   1. How to create a report using design view?
   2. How to create a report by using wizard?
   3. Discuss about sections of a report.
Lesson 11.3: Advanced Report

Learning Objectives
On completion of this lesson you will be able to learn:

- about Report Writer Toolbox.
- printing a report.
- display date and time and page numbers.
- calculating field.

11.3.1 Report Writer Toolbox

Label-A Label control is a graphical control which is used to display text,
1. Open a report in design view.

2. Click the Label tool in the toolbox.

3. Click the section on the report where you want to place the label.

4. Set other properties to customize the visual appearance of the label and its contents.

* To set properties for control click the control and then click Properties on the toolbar.

Text Box-Textbox control is used to display information at design time or assigned to the control in code at run time.

1. Open a report in design view

2. Click the Text box in the Toolbox.

3. Click in detail section where you want to place the textbox.

4. Set other properties to customize the visual appearance.
* To set properties for control click the control and then click Properties on the toolbar.

Check box - Check box displays a True/False or Yes/No option.
List Box - List Box display a list of items from which you can select one.
Image – Image control is used to display icons, bitmaps etc.
Rectangle control- Rectangle control adds rectangle to a report.
Line control- Line control draws a straight line to a report.
Pointer- pointer provides a way to move and resize the controls and reports.

11.3.2 Drawing Rectangles and Lines
You can draw rectangles or lines in a report for separating different types of data. As for example a line could be drawn to separate headings from the data, or a rectangle could be drawn to enclose important summary data.

**To draw line or rectangle:**
1. In the report writer toolbox click on line control to draw a line or click on the rectangle tool to draw a rectangle.
2. Move the mouse pointer to the location at which you want to begin drawing and drag to draw.

   1. To change the thickness of a rectangle's border or of a line, click the rectangle or line, click Properties on the toolbar to open the property sheet, and then click in the Border Width button and then click the line thickness you want.
   2. To change the line style (dots, dashes, double, and so on) of a rectangle's border or of a line, click the rectangle or line, click Properties on the toolbar to open the property sheet, and then click a border style in the BorderStyle.

11.3.3 Show Current Date and Time in a Report
1. Open report in Design View.
2. From the Insert menu click Date and Time.
3. To include a date select the Include Date check box and then click a date format.
4. To include the time select the Include Time check box and then click a time format.
5. Click Ok.
11.3.4 Show Page Numbers in a Report
1. Open report in Design View.
2. From the Insert menu click Page Numbers.
3. Select the Format, Position, and Alignment.
4. Click Ok.

11.3.5 Calculated Field in a Report
Calculated field can be based on any expression. For example, to calculate house rent for employee, insert a calculated field with the multiplication expression basic salary * percentage of house rent.

To insert a calculated field:
1. Open report in Design view.
2. Click the Text Box tool in the toolbox.
3. In the detail section click where you want to place the text box.
4. Select the text box click Properties \( \text{Properties} \) on the toolbar and type the expression in the ControlSource property box.

5. Or click the Build button \( \text{Build} \) next to the ControlSource property box.

For example, to multiply the value of field A by 2 types: 
\[ = [A] \times 2 \]

11.3.6 Calculate a total or other aggregate values
Calculate a total or average on a report Open a report in Design view.

1. Click the Text Box tool \( \text{Text Box} \) on the toolbox.

2. Do one of the following:
   - To calculate a total or average for a group of records, add the text box to the group header or footer.
   - To calculate a grand total or average for all records in a report, add the text box to the header or footer of the report.

3. Select the text box and then click Properties \( \text{Properties} \) on the toolbar.

4. In the ControlSource property box type an expression that uses the Sum function to calculate a total or the Avg function to calculate an average.

11.3.7 Printing a Report
Any report can be outputted to printer.
Introduction to Form

To Print a Report from Print Preview
Click the print button on the Print Preview toolbar to print document. The print dialog box will not appear.

To Print a Report using toolbar
Choose File → Print from the menu bar to open the Print dialog box.

Make any necessary changes to the Print Range, Number Copies sections of the Print dialog box.
Click the OK button to print the report.
Exercise

1. Multiple choice questions

a. Generally which control is used for separating different types of data?

   i) line
   ii) rectangle
   iii) list box
   iv) both i and ii

b. To calculate a grand total for all records in a report add text box to the

   i) header of a report
   ii) footer of a report
   iii) header or footer of a report
   iv) page header of a report.

2. Analytical questions

   1. Write the uses of rectangles and lines.
   2. How to display current date and time and page numbers in a report.
   3. How to calculate a total or other aggregate values in a report.
   4. How to calculate a field in a report.

Hands on Practice

Create a report containing report header as Bangladesh Open University, page header as Result sheet, page footer as page number and printing date and the report layout will be tabular format and save the as sst.